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About the Quick Start Guide

This Quick Start Guide is task-based, and is designed to help new Taper-Plus
users create basic roof estimating projects quickly and easily. It walks you
through a sample job-step-by-step-giving you the basics needed to start using
Taper-Plus to generate roofs and create estimates for your own projects.

Information in this chapter includes:
* using this guide

e getting help with your projects

e getting product information

* anoverview of the sample job you will create
* atable of keyboard shortcuts for entering coordinates

Using the Quick Start Guide

This guide presents information in a consistent way to help you quickly find what
you need. Simply follow the steps as they are set out for you. Note that if
someone in your office has already been using the program, various options and
screens may look slightly different. All screens in this tutorial are shown as if the
program were installed selecting the NEW option during installation.

Throughout the guide, you will notice Tips! in the left hand margin. These tips
suggest shortcuts, and act as hints to help you use Taper-Plus efficiently.

Getting Help

Automated Systems Research provides two ways for you to get help for your
Taper-Plus estimating projects:

* online help
* technical support
Online help

Our online help is task-based, and provides detailed information on Taper-Plus
features and optional settings.

To view Taper-Plus online help
e Press F1to view help for a particular menu option, toolbar button, or window
¢ On the Help menu, click Table of Contents

Technical support

If you cannot find the technical help you need in this guide or in the online help,
our Technical Support Representatives can help. Here is how to reach them:

Automated Systems Research

Toll free: 1-800-818-2051 Phone: 604-539-0122
Fax: 604-539-1334 Email: support@asrsoft.com Web: www.asrsoft.com

Getting Product Information

For information on this product, as well as our entire line of roofing estimating
software products, please visit our website at www.asrsoft.com, or call us at the
numbers listed above. One of our helpful company representatives will be happy
to assist you.
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About the Sample Job

The sample job teaches the BASIC functions of Taper-Plus, it does not introduce
advanced features of the application. The job you create using this guide is by no
means indicative of the limits of the software. It is simply the best way to
introduce you to the interface.

For a more complete description of Taper-Plus’ many advanced features, press F1
at anytime to view the online help.

Here is the layout of the sample job you will be working on.

You will want to print this page to refer to while you work on the sample job.
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Figure 2-1 The sample job

The instructions set out in this sample job use a combination of keyboard and
mouse entry methods, depending on the circumstance.

For information on entering roof coordinates using various entry methods, press
F1 to view online help for Taper-Plus.

The following table contains all of the keyboard entry shortcuts you will need
while working on the sample job.

Direction shortcut keys

U=up V = vertical

D =down S = sloped

R = right A =angled

L = left B = back up a step (undo)

H = horizontal M = change coordinate display
Q = quit section (closes section automatically)
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Lesson 1 : Drawing a Roof

The first lesson in this sample project walks you through creating a project.

Included in this section:

* Opening a new project

* The Taper-Plus Quick Menu
* Adding a roof

e Adding a drain

* Adding a low area on a drain
¢ Changing drawing options

* Viewing project estimates

* Generating reports

* Printing
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Opening your Project

To open a new project
1. On the File menu, click Open Project.

The Open Project window appears as in Figure 1-1.

Open Project

Project Mame: _ Diirecton:
D:\ASK PROGRAMSATAPERS 10

[]

Drrive:
|D: paTA) =l

Cancel | ™ Shaw Project Preview

Figure 1-1 The Open Project window
In the text entry box, type the name of your project. Call this job Sample 1.
Click OK.

The Project Title window appears, as in Figure 1-2.

Project Title @
Scale: Template:
[0125 infft |DEFALLT |

Project Mame:

Address: [

Architect: |

1~ Comments

Figure 1-2 The Project Title window
4. From the Template drop down menu, select DEFAULT, and click OK.
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The Quick Menu

You can right-click your mouse in the drawing area at any time to view a menu of
common tasks. This menu is called the Quick Menu, as seen in Figure 1-3, and
can be customized to display only the tasks you use most often. For information
on customizing the Quick Menu, see the online help.

Previous Command: Add Roof Section...
Add Roof Section...
Defaulks, .,

Undo: {Mathing)
Redo: {Mathing)

Copy Roof Section. ..
Move Roof Section, ..
Rotate Roof Section. ..

Figure 1-3 The Quick Menu

Adding a Roof

A roof section can be an entire roof or any part of a complete roof. In this project
you will add an entire roof.

To add a roof

1. On the main menu, click Add, then click Roof Section, or click the Add Roof
icon, .

The Add Roof Section window appears as in Figure 1-4.

Add Roof Section El

Roof Section M ame:

[

Fioof Section Type

+ Regular
~

~

-

[ lgnore Snap Yalue for First Point

Cancel

Figure 1-4 The Add Roof Section window

Notice that the Roof Section Name defaults to A. You can name your roof
sections, for example “garage roof” by typing the name in the Project Name
text box.

2. Click OK to accept the default name.
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Tip!

To choose a new 3.
position for your

starting point, type A
(adjust) and enter

the new coordinates.

4,
5.

Tip!

If you make a

mistake at any time,

simply type B to

back up a step or

several steps.
9.
10.
11
12.
13.
14.
15.

Quick Start Guide

The Add Roof Section window closes, and a crosshair appears in your
drawing window. The command line at the bottom left of your screen tells
you what to do next. It looks like Figure 1-5.

I;ENTEH SECTIOM START POINT A [Adjust) I

Figure 1-5 The Add Roof message bar

By default, the starting point is X:0.0000 and Y:0.0000. Press Enter to accept
the default starting point.

The command line now tells you which keyboard options are available to
enter the next point.

EMTER MEXT POINT  UDRLHYSCABM ar O [Cuit)

Figure 1-6 Command line
Type U to go up.

A text box opens in the task bar on the bottom-left corner of your screen, as
in Figure 1-7.

24 . I
Figure 1-7 The Coordinate Entry box

ILIF':

Type 24 in the text box, and hit Enter.

Type R to go right, type 10 in the text box, and press Enter.
Type U to go up, type 8 in the text box, and press Enter.
Type R to go right, type 32 in the text box, and press Enter.

You can move your mouse in the general direction you want to place a point.
Doing so eliminates the need to enter negative coordinates.

Move your mouse down and to the right.

Type S to enter a slope.

Type 6 in the horizontal text box, tab to the vertical text box, and type 5.
Press Enter.

Type D to go down, type 27 in the text box, and press Enter.

Type Q to close the roof outline.

Four options appear on the task bar at the bottom left of your screen, as in
Figure 1-8.

Huorizontal ] Yertical 1

Figure 1-8 The Close options
Type H, or click Horizontal to close your roof outline horizontally.

Your roof outline should look like Figure 1-9.
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Figure 1-9 Outline of Roof Section A

Zooming into a Roof

You can quickly zoom into the roof section to get a closer view.

To zoom into the roof section
* On the main toolbar, click Zoom Current ZE .

Adding Drains

There are several ways to add drain locations. You can use your mouse or enter
the coordinates using your keyboard. In this lesson, you will use the keyboard to
add drains to your roof.

To add a drain using the mouse
1. On the main toolbar, click Add Drain |2+ 1.

Your cursor becomes a crosshair, and the following appears in your message
bar:

OSITION DRAIN - A [Adust]  C[Center]  ® [Toogle Mode] R [Refterence]

Figure 1-10 Positioning the drain
Move your cursor Up and to the Right of the reference point.
Type A to position the drain using the keyboard.

Type 16 for the Horizontal drain coordinate, tab to the Vertical drain
coordinate box and type 16.

Press Enter.
Move your cursor to the Right of the first drain.

Type A to position the second drain using the keyboard, and type 32 in the
Horizontal drain coordinate box.

Ensure that the Vertical drain coordinate is set to 16, and press Enter.
Press ESC to stop adding drains to the roof.

Your roof outline looks like Figure 1-11.
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New drains A A

Figure 1-11 Roof outline showing added drains

Using Toolwindows

The toolwindows are located on all four sides of the drawing window. Each
toolwindow can contain multiple toolbars. Toolbars are small windows that
contain groups of icons that give you quick access to a set of related commands
as shown in Figure 1-12.

Add Low

4
~+o+ || ===
t
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e
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<[+
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Figure 1-12 Add low area toolbar

To customizeor remove toolwindows select Settings in the View menu and click
on Toolwindows.

Adding Low Areas on Drains

You can quickly add low areas on all drains in a roof section with the Add Low
Area toolbar

To add a low area on all drains
* On the Add Low Area toolbar, click Low All Drains £

The low areas are added automatically, and labeled 0 and 1. Tapered
insulation is drawin on the roof section.

The roof should look like Figure 1-13. (If it looks different - select Draw from the
View menu. Then select Rows for the Section Taper and Section Letters and
press Enter.)
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Figure 1-13 Roof outline with low areas

Viewing Estimates

To view an estimate of your roof plan

On the main toolbar, click Estimate .

Your drawing appears in your drawing
window. Notice each taper panel is now labeled. You should estimate your
projects before generating reports.

Generating Reports

You have several choices of reports from which to choose. For this sample job,
you will create a summary cut list report.

For more information on generating reports, click F1 to view our online help.

To generate a report
1. On the Output menu, click Reports.

The View Reports dialog box opens, as in Figure 1-14.

Yiew Reports E|
Quick Generate

" Bows ™ Cutlist O Price " Breakout Generate...‘ Current ‘ All | Surnrnary |

Cut List report has not been generated.

Figure 1-14 The View Reports window

At the top of the dialog box, click Cut List to select a cut list report.
In the Quick Generate area, click Summary.

If the Taper Coverage dialog box opens, click OK.

The View Reports window changes and quickly generates a summary report
of all the panels required for the project, as in Figure 1-15.
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Yiew Reports g|
Quick Generate
" Bows ™ Cutlist O Price " Breakout  Generate... | Current | All | Surnrnary |
Autonated Systems Research 2007/07/24 10:34.58

CUT LIST REPORT

PROJECT: PROJECT FILEMAME: SAMPLE 1
ADDRESSE: SUMMAPRY OF ALL SECTIONS: A

MODULE SLOPE DIMENSIONS QUANTITY % WASTE EDL SQR FT ERD FT

SECTION TAPERED PANELS 1: (IS04: 4.0 ¥ 4.0) default

H 0.z500 0.500-1. 500 46 24.5 46 736 736.0

T 0.z500 1.500-2._500 (3] 1.8 (3] 1083 217&.0
SUETOTAL: 1324 £231Z.0

SECTION FILL PANELS 1: (4.0 X 4.0} default

1.000 11s 0.1 11s 1356 1856.0

SUBTOTAL: 1358 1856.0

TOTAL EOAPD FEET = 476300

TOTAL SQUARES HANDLED AND APPLIED = 36.80 3Z.35

AREL AND AVERAGE R-VALUE OF TAPERED = 1441.0 0.00

AREL AND AVERAGE R-VALUE OF NON-TAPERED (WITH INS) = 0.0

AREL AND AVERAGE R-VALUE OF NON-TAPERED (WITHOUT INZ) = 0.0

AREL AND AVERAGE R-VALUE OF LOW AREL = 0.0

AREL AND AVERAGE R-VALUE OF HIGH AREL = 0.0

AREL AND AVERAGE R-VALUE OF CRICEETS = 0.0

TOTAL AREA AND AVERAGE R-VALUE = 1441.0 0.00

TOTAL TAPERED (INCLUDING LOW/HIGH AREAL & CRICEETS) = 1441.0 o.00

MINIMIM AVEPRAGE MAHTIMITM

Figure 1-15 A summary report in the View Reports window

5. Click OK to close the View Report window.

Note that you can also export your report automatically to an Excel spreadsheet.
In the View menu, select Settings, then click on Report Settings and make sure
Export Excel File is checked. Then click on Directories Settings and choose where
you want the Excel file stored. If you select Standard the the Excel report will be
stored in the Project directory. If you select Specify, then you can choose a
different directory. The Excel files are named as follows: PROJECTNAME_REPORT
TYPE.xIs

Printing your Roof Plan

Tip!

For information on
saving images to be
viewed and modified
in other CAD
programs--.dxf files--
or popular graphic
programs--.tif files,
please see our online
help.

10

When you have completed drawing your roof plan, you can generate a roof plan
image to send directly to your printer.

To print a roof plan
1. On the Output menu, click Plot.

The Plot Preview window opens with a copy of the project in the center of the
page, as in Figure 1-16



Tip!

For information on
using the Options
and Move buttons to
change your roof
plan preview, see the
online help.

Caution!

Clicking Cancel
closes the Plot
Preview window
without saving any
changes you made to
your roof image.

Printing your Roof Plan

Lesson 1 : Drawing a Roof

Lot

Figure 1-16 The Plot Preview window

In the Plot Type box, choose Printer Plot.

Select Bold Outline. NOTE: You can print in black and white by selecting
Monochrome.

In the Section Taper area, select Grid.

In the Size box, select A.

The A size is 8 1/2 by 11 inches.

Click Update Preview.

Click Print.

A dialog box appears asking you if it is OK to print, as in Figure 1-17.

0O to Print? Print and Exit | Piint I Cancel |

Figure 1-17 The Print dialog box

Click Print and Exit to print your roof plan. Or click click Cancel to close the
dialog box and return to the preview pane without sending your roof plan to
the printer. By pressing F1 while you have the plot window open, you can
learn more about all the options available. After you’ve completed all the
tutorials, be sure to check out the online help or manual for information on
Borders and Default Header on the Setup menu so that you can customize
your plot layout for your company.

You have completed Lesson 1. Lesson 2 covers Modifying your Design.

11
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Lesson 2: Modifying a Design

The second lesson in this sample project walks you through modifying the
taper design created in Lesson 1.

Included in this section:

¢ Creating a modified 2-way tapered layout
e Erasing low areas

* Adding a low area between drains

¢ Adding a full cricket

* Viewing your new tapered design
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Creating a Modified two-way Tapered Layout

You can create a 2-way tapered design by entering a linear low area-in this case,
between two drains. Since we created a 4-way design in Lesson 1, the first step
is to get rid of the existing low areas.

Erasing Low Areas

To erase low areas

1. On the Erase toolbar, click Erase Low/High Area

[ Oron the Erase
menu, click Low/High Area. '

Your mouse pointer turns into a box.

2. Place the box over the first low area (the left drain, as indicated in Figure 2-
1), and click to select.

| e
L)
i N

Place T~ A I # Place
cursor T €l oy : = cursor
here and ] “T‘a‘ _\J : here and
click / Y ¢ | click

4 ><+2

ez

Figure 2-1 Select the first low area

The Erase Low Area dialog box opens, as in Figure 2-2.

Erase Low firea [§_<

e

About ko Erase Low Area: O

(0] 4 | Cancel |

Figure 2-2 The Erase Low Area dialog box
3. Click OK.

The first low area is erased.

Place the cursor over the second low area (the right drain) and click.
When the Erase Low Area dialog box opens, click OK.
The second low area is erased.

Your outline is redrawn without the tapered insulation.

14
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Adding a Low area Between Drains

To add a low area between drains

—a

On the Add Low Area toolbar, click Add Low Area Between Drains |t
the Add menu, point to Low Area, then click Between Drains.

.Oron

Since there are only two drains on the roof, the low area is drawn
automatically, as in Figure 2-3.

o

o

f " h B W HeZ

i

o

Figure 2-3 Low area between drains

Adding a Cricket

Taper-Plus can add a cricket in 12 different ways, and each is recognized as a
unique type. In this lesson, you will add a full cricket.

Tip!

When the total
width of the cricket
panel is important,
choose the
Perpendicular cricket
type. This setting
indicates that the
cricket width is the
perpendicular
distance between the
cricket edge and the
cricket high point.

To add a full cricket

1.
2.

On the View menu, click Settings, then Cricket Entering.
Verify that the cricket type being used is Normal.

The normal setting indicates that the cricket width is the distance between
the two cricket tips.

Click OK to close the Cricket Entering window, and click OK again to close the
Settings window.

On the Add Cricket toolbar, click Add Full Cricket @» . Or on the Add menu,
point to Cricket, then click Full.

The following options appear in your message bar at the bottom left of your
screen:

[ 3 IR

Figure 2-4 The Enter First Cricket Point message bar

Since you want to use the mouse to attach the cricket to the drains, you will
use Attach mode. Attach mode allows you to attach a new point to an
existing point without having to calculate the exact coordinates.

15
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Tip!

Attach mode only
works when there is
an existing point to
attach to.

9.

Quick Start Guide

On the main toolbar, click Attach | P| I to turn on attach mode.

The icon on the toolbar turns blue to indicate that it is on, and your cursor
becomes a box.

Place the cursor on the first drain (left), and click.
Place the cursor on the second drain (right) and click.

A cricket is created using the drains as the end points, and the following
prompt appears in your message bar at the bottom left of your screen:

Figure 2-5 The Cricket Tip message bar

Type V for value, then type 8 in the cricket width text box, and press Enter.

The complete cricket appears in your drawing window, as in Figure 2-6.

T
Htd
new crigket > ';I
e N AR O L R,
+
Ny
a2
T2

Figure 2-6 Your roof outline with the added cricket

Right-click or press ESC to exit the command.

Viewing the Tapered Layout

16

You can use the drawing options to view your projects in different ways. You'll
view the layout without the rows of tapered insulation.

To view your layout

1.

On the main toolbar, click Draw m

The Drawing Options window opens.

In the Section Taper area, click Layout.

In the Cricket Taper area, click Layout.

The Drawing Options dialog box should match Figure 2-7.
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Drawing Options [X]
~Section Taper 1 Cricket Taper
" Gnd o Grid
" Raows " Rows
 Layout " Layout
* Mane " Mone
Section Letters - 1 - Cricket Letters
Al Al
& Fows ' Rowg
" Mone " None
¥ LowHigh Area Numbers T D008 [mane =
Iv Cricket Mumbers I~ Flat Image ™ Help Grid
W Fioof Mames ¥ Motes ¥ Outlines
v Dimensions ¥ Auto Redaw
¥ Anmows
()8 | DXF Layers ] Cancel

Figure 2-7 The Drawing Options window
4. Leave all other settings as they appear, and click OK.

Your drawing should look like Figure 2-8.

i P
2 | T

Figure 2-8

Note that the Quick Draw button in the Status Bar gives you a quick access to
commonly used Drawing Options

You have completed Lesson 2. Lesson 3 covers Voids and Interior Sections.

17
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Lesson 3: Voids and Interior
Sections

The third lesson in this sample project introduces adding different types of
roof sections. You will continue to modify the roof plan you worked on in the
previous two lessons.

Included in this section:

Adding voids

Adding an interior section
Adding a low area on an edge
Adding long crickets
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Adding Voids

20

Void sections don’t have any insulation. You add a void in much the same way
you added a roof section in Lesson 1. In this lesson, you will add two identical
voids.

To add a void
1. [If attach is still turned on from the previous lessons, click Attach [2| to turn
it off.

2. On the main toolbar, click Add Section . Or on the Add menu, click Roof
Section.

The Add Roof Section window appears, as in Figure 3-1.

Add Roof Section E|

Roof Section Marne;
|B

Roof Section Type
" Regular
" Interiar

* Yaid

[~ Use Reference from &nother Foof Section

[~ Ignore Skap Walue for First Paint

Cancel

Figure 3-1 The Add Roof Section window

3. Inthe Roof Section Type area, click Void, then click OK.

On the main toolbar, click Reference Point @ , then click the point
indicated in Figure 3-2.

This changes the location of the reference point.

R\ Y £

X+g 1 1

Y +2

h 3
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Figure 3-2 Changing the reference point

5. Using your mouse and watching the coordinate boxes on your screen, move

right 7 and down 3.
6. Click to set your new starting point.
7. Type R to go right, type 3 in the text entry box, and press Enter.
8. Type D to go down, type 3 in the text entry box, and press Enter.
9. Type Q and select Right Angle to close your roof section at a 90 degree right
angle.
Note
Right Angle is only The Select Enclosing Section window opens, as in Figure 3-3.
available when a
right angle is ) . 3
possible Select Enclosing Section |'5_(|

] | Cancel

Figure 3-3 The Select Enclosing Section window

10. Click OK to enclose the roof section and return to your drawing.
Now you can add the second void.

11. Click Add Section . Or on the Add menu, click Roof Section.
The Add Roof Section window appears, as in Figure 3-4.

21
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12.
13.

14.
15.
16.

17.

18.

19.
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Add Roof Section B|

Roof Section Manme:

C

Roof Section Type

&+ Regular
" Interior

" Yoid

[ Use Reference from &nather Roof Section

[ lgnore Snap Walue for First Point

ak. | Cancel

Figure 3-4 The Add Roof Section window

In the Roof Section Type area, click Void, then click OK.

Click the Reference Point icon, @ ,and position the reference point as
shown in Figure 3-5.

Figure 3-5 Changing the reference point again

Using your mouse, move your cursor to the left 5, and down 3.
Click to set your starting point.

Type D to go down, type 3 in the text entry box, and press Enter.
Type L to go left, type 3 in the text entry box, and press Enter.
Type Q, then select Right Angle.

The Select Enclosing Section dialog box opens once more, as above in
Figure 3-3.

Click OK to select A and close the Select Enclosing Section dialog box and
return to your drawing.

Your roof outline looks like Figure 3-6.
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two new voids Y+2 i-\ B
L

eed ¥ K —= XY K+dy ]

Y+ 2

i
a3

3

Figure 3-6 Your roof outline showing two new voids

Adding an Interior Roof

Interior roofs are enclosed by other roof sections. You can add them the same
way you added voids.

To add an interior section
1. On the main toolbar, click Add Section .

The Add Roof Section window opens, as in Figure 3-7.

Add Roof Section E|

Roof Section Mame:
[

Roof Section Type
" Regular
& |nteriar

 Void

[~ Use Reference from &nother Roof Section

[~ lgnaore Snap Yalue for First Paint

Cancel

Figure 3-7 The Add Roof Section window

Note that the Roof Section Name is D. This is because you added two voids
(sections B and C).

2. Inthe Roof Section Type area, click Interior, then click OK.

The Add Roof Section window closes and you are returned to your drawing
window.

3. On the main toolbar, click Reference Point @ .

23
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Tip!

You can also use
decimals to enter
feet and inches. For
example, 14’6 can be
entered as 14.5.

24
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4. Click the bottom-left corner of the roof outline to make this corner the new
reference point.

5. Using your mouse, move your cursor up 5 and to the right 18.
6. Press Enter.
7. Type Uto go up, type 8 in the text entry box, and press Enter.

8. Type R to go right, then type 10’4 in the text entry box, and press Enter.
9. Type D to go down, then type 8 in the text entry box, and press Enter.
10. Type Q to quit, then type H to close the section horizontally.

The Enclosing Roof Section window appears, as in Figure 3-8.

Select Enclosing Section |z|

(] % | Cancel

Figure 3-8 The Select Enclosing Section window
11. Select A and click OK.

Your interior roof is added, and looks like Figure 3-9.

Figure 3-9 Your outline with an interior roof
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Adding a Low Area on an Edge

To add a low area on an edge

1. On the Add Low Area toolbar, click Add Low Area on Edge . Oronthe
Add menu, point to Low Area, then click On Edge.

Your cursor becomes a box.

2. Select the top edge of the interior roof, as in Figure 3-10.

Click here

i

Figure 3-10 Select the top edge of the interior roof

Your roof outline looks like Figure 3-11.

- =

i =y

Figure 3-11 Your roof outline with a low area on the interior roof

3. Press Esc to exit the command.

Adding Long Crickets

The next step is to add long crickets to the voids and interior section you created
earlier in the lesson.

To add a long cricket

1. On the main toolbar, click Attach | & Ito turn on Attach mode.

2. Atthe top left side of your drawing area—-immediately under the main menu--
select A from the Section drop-down list., as shown in Figure 3-12 and left
click or press Enter.
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PROJECT

B
C
D

Figure 3-12 Selecting a roof section

3. Onthe Add Cricket toolbar, click Add Long Cricket <4 Or on the Add menu,
point to Cricket, then click Long.

4. Place your cursor on the top left corner of the first void and click, as in
Figure 3-13.

Click here —

Figure 3-13 Select the first point for your long cricket

5. Place your cursor on the top right corner of the first void (section B), and
click.

The Cricket Tip message appears, as in Figure 3-14.

Figure 3-14 The Cricket Tip message bar

Type V for value, then type 1 in the text entry box.
Press Enter.
Your message bar asks “Is this the correct side?”. Press Enter for Yes.
Now you can add a long cricket on the second void.
9. Place your cursor over the top left corner of the second void and click.
10. Place your cursor over the top right corner of the second void and click.
11. Type V for value, then type 1 in the text entry box.
12. Press Enter.
13. Press Enter again when you are asked “Is this the correct side?”

Your roof outline looks like Figure 3-15.
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Adding Long Crickets

Long crickets

onvoids — ., —— Pl

2

Figure 3-15 Your roof outline with long crickets on voids

Now you can add a long cricket on the interior roof.

14. Place your cursor on the bottom left corner of the interior roof and click, as

15.
16.
17.
18.

in Figure 3-16.

Click here — P

Figure 3-16 Select the bottom left corner of the interior roof

Place your cursor on the bottom right corner of the interior roof and click.

Type V for value, then type 3 in the text entry box.
Hit Enter.

When you are asked “Is this the correct side?,” click No.

Your roof outline looks like Figure 3-17.
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ong cricket > N2
on interior

Figure 3-17 Your roof outline with a long cricket on the interior roof
19. Press Esc to exit the command.

You have reached the end of Lesson 3. Lesson 4 covers working with the

Materials Database.
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Lesson 4: Letter Schemes and
the Materials Database

The final lesson in this sample project introduces you to customizing Letter
Schemes and the Materials Database.

Included in this section:

¢ Creating letter schemes
* Accessing the materials database
* Specifying material data
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Creating Letter Schemes

In this lesson you will set up a letter scheme.

To create a letter scheme
1. Onthe Setup menu, click Letter Schemes.

The Setup Letter Schemes dialog box opens, as in Figure 4-1.
Setup Letter Schemes |z|

Letter Scheme:

1502
1504

Open... | Copy... ] Delete ] Cloze ]

Figure 4-1 The Setup Letter Schemes dialog box

2. Inthe Letter Scheme text entry box, type the name IS08, and click Open.
The Generate New Letter Scheme dialog box opens, as in Figure 4-2.

Generate New Letter Scheme |z|

— Letter Scheme Type —
% Single Slope
" Multi Slope

] ] Cancel

Figure 4-2 The Generate New Letter Scheme dialog box
3. Ensure that Single Slope is selected, and click OK.

The Setup Single Slope Letter Scheme: ISO8 window appears, as in
Figure 4-3.
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Single Slope Letter Scheme Properties: 1508

Creating Letter Schemes

- General Information

Letter Scheme Description:
Panel Width: 4 ft Panel Length: |4_ ft
Mitred Valley Panels Indicatar: IV— Mitred Hip Panels Indicatar: IH—
i~ Inzulation Thickness and Slop ~ Repetitian
Minimurn Thickness: ID— in Mairnum Mumber of Repetitions: I]D—
Mazimum Thickness: |2— in Generate Repetition Name: m
Slope of Insulation: W indft Separatar: m
Sequence Type: W
—Momal Letters————— ~Special Letters——————————— - Constant Letter
Mirirnum Letter: IA— Nurnber. lm I™ Use Constartt Letter
™ Double Letters Special Letter: 5 Constant Letter. |
Pasition lm ¥ Standard Fosttion
I | Diouble Specialiletter
I” | Repeat Speial Letter

I

Generate Scheme |

Cancel |

Figure 4-3 The Setup Single Slope Letter Scheme: ISO8 window

Under General Information, enter a panel width of 4 feet, and a Panel Length
Under Insulation Thickness and Slope, enter a Minimum Thickness of 0.5

Check to make sure the Slope of Insulation is set at the program default of

0.125 in/ft. This means that the panel rises 1/8 of an inch for every foot.

Under Generate Repetition Name, select Fill.

4,
of 4 feet.
5.
and a Maximum Thickness of 2.5.
6.
7.
9. Under Separator select +.
10.
11. Click Generate Scheme.

The new letter scheme appears, as in Figure 4-4.

Setup Letter Scheme: ISO8

New Letter Scheme (4 x 4)

Under Repetitions, enter 10 for the Maximum Number of Repeptitions.

Under Normal Letters, select A for the Minimum Letter.

Panel | Repeat | Min Thick | Max Thick [ Fil Thisk | Siope [~
A 05 1 0 0125 E
B 1 15 0 0125
& 15 2 0 0125
D 2 25 o o125
A +2 25 3 2 125
B +2 3 35 2 0125
£ w2 35 4 2 0125
D +2 4 45 2 0125
A +4 45 5 4 0125
B +4 5 55 4 0125 "
Ok | Add Panel J | Regenerate Scheme. .. I Print Cancel

Figure 4-4 Your new single slope letter scheme

12. Click OK to close the Setup Letter Scheme dialog box.

13. Click Close to return to the drawing area.
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Accessing the Materials Database

The Taper-Plus database is designed to provide total flexibility in specifying your
roof system. Initially, you have some work to do to customize the database
according to your requirements; however, doing so will save you time when you
are estimating jobs and ordering materials.

To view the materials database
* On the Setup menu, click Materials.

The Setup Materials dialog box opens as in Figure 4-5.

Setup Materials E|
iD# | Desciption [ 57 [um] UnitCost [ Makup 2 | Bal [Rvaluesin
o defaul T B 0 1 0
B Perlite T |8 01 1 1
BE Perlite Fill F B 1 01 1 1
]z Eps T B 0125 0.25 1 |am
s Epsra F B 0145 0.25 1 lam
|5 150 T B 0.3 0.3 1 B
BE 50 Fill F B 03 0.3 1 B

QK | Add | Copy | Delete | Itemize... Frint Cancel

Figure 4-5 The Setup Materials dialog box

Specifying Material Data

You can specify the dimensions and costs of the materials you use in your
projects.

The materials database has the following columns:

Material data columns

Column title What is it?

ID the unique number given to the material

Description the type of material

ST the material sub-type, either T for taper or F for Fill

UM the unit of measurement (item, sq ft, bd/ft)

Unit Cost the price of a material, per unit of measure

Markup % the markup expressed as a decimal (for example.25 is
25%)

Bdl the number of panels needed per bundle (only shown if
known). Note: the bundle value is only useful for a
material with only one thickness. For materials with
multiple thicknesses, use the itemize option.

R-Value/In the measure of thermal resistance
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Changing Material Data

When you start using Taper-Plus for your own projects, you will need to change
material data from time to time. In the next step, you will change the price of ISO
to .39.

To change material data
1. Inthe Setup Materials dialog box, click ISO.
2. Tab over to the Unit Cost column and type .39.
The Unit Cost is changed to .39/unit of measurement.

If you were only making the one change, you would click OK now, but you are
going to add a material to the database using the same window.

Adding Material Data

Just as you will need to modify information about materials in your database,
occasionally you will need to add new materials. For example, in the next step
you will add a regional-specific material called ISO - West.

To add a material to the database
1. Click Add to add a material.

A new row is added, and a unique ID number is generated for the new
material, as in Figure 4-6.

Setup Materials

D Description [T [uM] UnitCost [ Makup2 | Bl [Rvaluedin]
#0 default T B |1 ] 1 0
EE Perlite T B 11 0.1 1 1
BE Perlite Fil F B 1 a1 1 1
Lls Eps T B 0125 0.25 1 ame
s EpsFa F B 0145 0% 1 A
BE 150 7 B |03 0.3 1 5
BE 150 Fill F B 03 035 1 5
- T i 0 1 i
Ok, | Add Copy Delete Itemize... Frirt Cancel

Figure 4-6 The added row

Tab to the Description column and type ISO - West.
Tab to the Unit Cost column and type .44.

Tab to the Markup column and type .35.

o @D

Tab to the R-Value/In column and type 6.
Your Setup Material dialog box looks like Figure 4-7.
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Setup Materials [g|
D% | Desciption [T [um] UnitCost [ Makup2 | Bl [R-alue/in]
o defaul T B 1 0 1 0
1 Perite T B 1 01 11
BE Perite Fill F B 1 01 1 1
Hz  EPs [T 8 |oam oz 1 |amm
s EPsFl F B |04 0.25 1 lam
BE 150 T B 03 0.3 1 E
e soFm F B |03 0.35 1 s
FE Jiso-west T B 4 5 16

QK | Add Copy ] Delete Itemize. .. Frint Cancel

Figure 4-7 Your new material data
6. Click OK to save your new material data.
Note: For insulation materials with non-linear R-Values or pricing, you must
itemize the materials. If you itemize fill thicknesses you will also have to setup a
different material for each sheet size, for example, 4x4 and 4x8.

For further information on itemizing materials, see the Taper-Plus online help.

Congratulations! You have completed the final lesson of the Taper-Plus Quick
Start Guide.

To learn about some of the more advanced features in Taper-Plus, see the Taper-
Plus Advanced Tutorials.
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